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About This Product
About This Product
Tutor Author is a tool that simplifies the procedure-writing process by providing:

• A methodology that helps you identify and organize critical information 

• A predefined structure that supports the organization of this information

• Predefined styles that allow you to format a procedure quickly and consistently

• System-generated flowcharting of your procedures

• System-generated renumbering of primary procedure tasks

• System-generated conversion to HTML, including hyperlinks to other documents 
and hypersensitive flowcharts

The Tutor Author User’s Guide includes the following sections:

It is suggested that you read “What Is a Procedure?” first, then complete the Author 
tutorial before using this product to create procedures.

The Tutor Author User’s Guide is designed to provide a quick overview and 
introduction to the product. Ongoing reference information and workflow descriptions 
are included in the Tutor document control procedures and instructions, listed below.

For information on installing this product, refer to the Tutor Implementation User’s 
Guide and the Technical Issues section of this guide.

Topic Description
What Is a Procedure? A quick overview of the Author procedure—what is in it, 

when to write one
The Author Template A brief discussion on the Word template used by Author and 

its impact on procedure writing
Author Tutorial A hands-on instruction intended to provide immediate 

success in composing a procedure
Publishing on the Web Instructions for creating HTML versions of your procedures 

that include hyperlinks
Miscellaneous Features A description of the Author toolbar and the Author menu 

items. 
Advanced Features Instructions for customizing Author to fit the needs of your 

environment
Avoiding Errors Tips for avoiding the most commonly made errors
Technical Issues A description of the hardware and software requirements in 

order to load Tutor, the Word settings required by Author, 
and instructions on how to install Author
.....................................................................................................................................................
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The following documents can be found on the Tutor startup CD under the directory 
entitled Document Control.

For a complete discussion of the procedure-writing workflow, refer to:

• Writing a Procedure [INS1050A]

• Adding a Process Document [PRO1215A]

• Modifying a Process Document [PRO1156A]

Tutor Author may also be used to create and maintain other document types. For 
information on writing and formatting other types of documents using Author, refer to:

• Writing an Instruction [INS1051A]

• Writing a Navigation Instruction [INS1055A]

• Writing a Form Abstract [INS1056A]

• Writing a Reference Document [INS1057A]

For information on using Author to create student guides, refer to:

• Writing an Education Overview [INS1052A]

• Writing a Lab [INS1054A]

• Creating a Curriculum [INS1053A]

• Building a Student Guide by Job Title [PRO1217A]

• Building a Student Guide by Topic [PRO1218A]

Important: This product assumes you are familiar with Microsoft Windows and have 
an understanding of the use of templates and styles associated with Microsoft Word.
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What Is a Procedure?
What Is a Procedure?
In order to use Author, you will need to understand the characteristics of a procedure.

A procedure is:

• The complete documentation of an activity, including the policies governing the 
activity

• The tasks performed in the completion of the activity, and the people (by job title) 
who perform those tasks 

When Is a Procedure Necessary?

A procedure is necessary only if the activity being described:

• Is complex

• Involves risk

• Must be performed in a consistent manner 

Note: Not all activities require a procedure.

How Is a Procedure Organized?

A procedure includes the following sections:

• Scope: Describes what the procedure covers and what it does not cover.

• System References: Lists all of the application screens referenced in the document

• Policy: Lists all of the rules that directly affect the activity

• Responsibility: Identifies primary duties for each person who performs tasks in the 
activity

• Distribution: Lists each person who needs to receive a copy of the procedure

• Ownership: Identifies the person responsible for ensuring the procedure’s integrity 
and accuracy

• Activity Preface: Identifies the starting point (the trigger or catalyst) of the activity

• Tasks: Lists all of the tasks required to complete the activity

• Flowchart: A graphic representation of the activity at the task level
.....................................................................................................................................................
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What Does the Procedure Writer Need to Know?

To write an effective procedure, you must understand:

• The details of the activity that you are documenting (who, what, and when)

• How the activity is integrated with other activities

• The sequence of events—the beginning point, the ending point, and tasks that are 
dependent on other tasks
.....................................................................................................................................................
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The Author Template
The Author Template
The Author software includes a Microsoft Word template that enables you to format 
your procedures quickly and consistently. 

Every Author procedure is attached to AUTHOR.DOT, and every paragraph in an 
Author procedure is associated with a predefined style. In other words, all of the 
formatting is done for you. 

The table below shows the different types of formats used in a procedure and the 
paragraph style associated with each in the example procedure that follows.

Author adds a style bar option to the View menu that enables you to see the style 
associated with each paragraph in your document. These styles are critical to the 
flowcharting function and should be applied consistently and accurately in your 
Author documents.

Style Name Resulting Format
Page Title Issuing Material
Section Title Activity Preface
Body Text This activity is initiated by receipt of a material requisition.
Actor Stockroom Clerk
Task 1 1. Pick the material.
Note 1 Refer to them material requisition for the item numbers and 

quantities.
Task 1 2. Record the material picked on the material requisition.
Task 2 • Record the item numbers.
Task 2 • Record the actual quantities picked.
Task 2 • Circle quantities that are short.
Task 1 3. Update inventory.
Box Text Oracle Inventory

N—> Transactions—>Miscellaneous

Miscellaneous Transactions
Directive If issuing the material to WIP, goto task #3. Otherwise, 

goto task #4.
Task 1 4. Attach the material requisition to the production material.
Directive Goto task #15.
Task 1 5. Inform the Requester that the material is ready for pickup.
.....................................................................................................................................................
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Although Author automatically activates the style bar for you, it is possible for this bar 
to be turned off. If the style bar does not appear in your Author document, select View 
from the Main menu, then select Style Bar.
.....................................................................................................................................................
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Author Tutorial
Author Tutorial
This tutorial provides hands-on instruction in the use of Author. You will be opening a 
document in Author and writing a new procedure.

1 Open Author.

Author automatically opens Microsoft Word.

2 Select Create New Document, then click OK.

3 Select the desired language from the pop-up list on the right-hand side of the 
window.

Note: The language you choose will determine the language of the document 
skeleton provided by Author. You may also need to change your keyboard settings 
(Control Panel, Keyboard, Language) to allow for different language symbols.
.....................................................................................................................................................
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4 Select the Procedure document type from the list on the left-hand side of the 
window, then click OK.

Note: Author may be used to create other types of documents, such as instructions 
and forms. 

5 Type the title of your procedure under Document Properties. For example, type:

Washing the Car.

Whenever you open a new Author document, you are prompted for the document 
title.
.....................................................................................................................................................
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Author Tutorial
6 Click Update.

Author opens a document containing a skeleton procedure and then inserts the 
document title in the appropriate places.

The document title appears on the first line of the document and in the footer.

– Notice that the document looks like a normal Word document.

– Notice the Author toolbar.

– Notice the Author paragraph styles, which appear in the style bar to the left of 
the screen.
This option is controlled through the View/Style Bar selection.

7 Save the procedure under a unique filename.

– Select File—>Save As.

– Name this procedure PRO0001A.DOC.

Note: If you prefer to view the remainder of the tutorial instructions on screen:

8 Select Help from the Main menu.

– Select Author Tutorial.

– Select Options—>Keep Help on Top.

– Adjust the tutorial window to an appropriate size for your monitor.

Your screen may not be large enough to accommodate the on-screen tutorial.

Writing Procedure Tasks

Begin by skipping over the introductory sections in your procedure and going directly 
to the tasks. Note: Most writers prefer to write the tasks first, completing the other 
sections once the tasks are defined.

1 Scroll past the introductory sections to the shaded box containing the words “Job 
Title.”

Note that the paragraph style is Actor.

2 How to specify the actor for task #1:

– Position your cursor in the shaded box.

– Replace Job Title with Car Wash Supervisor.

– Do not press Enter.
.....................................................................................................................................................
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3 How to write task #1:

– Delete the two italicized paragraphs under the actor. 
These are writing instructions that are maintained in the procedure skeleton.

– Move your cursor to the task #1 paragraph.
This paragraph already includes the numeral 1 and is formatted in the Task 1 
style.

– Press End. 
This positions your cursor at the end if the tab.

– Type the following task:
Hook up the garden hose.

– Do not press Enter.

4 How to write task #2:

– Move your cursor down to task #2.

– Press End.

– Type the following task: 
Prepare the car wash solution.

– Press Enter at the end of the task.

This inserts a blank Task 1 paragraph.

5 How to write task #3:

– Do not type in the task number.

– Do not press tab or the space bar. (Leave your cursor at the left margin.)

– Type the following task at the left margin: 
Close the car windows.

– Press Enter.

6 How to write task #4:

– Do not enter a task number or a tab. 

– Type the following task at the left margin: 
Rinse the car.

– Do not press Enter.

7 Click the number (#) button on the Author toolbar.

This button automatically numbers (or renumbers) all paragraphs formatted in the 
Task 1 style.
.....................................................................................................................................................
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Author Tutorial
Note: When entering a new task, you can type in task numbers if you want. 
However, you must type the task number at the left margin, followed by a tab, 
followed by the task text. For example:

1. →text

8 How to flowchart your procedure:

Click the Flow button on the Author toolbar.

As long as your tasks are properly numbered, you may flowchart your procedure at 
any time. The flowchart appears at the bottom of the document.

You have now successfully written and flowcharted procedure tasks.

Writing Directives

What if task #3 is not performed all of the time, but only if the windows on the car 
have been left open?

You can specify this condition using a directive.

1 How to insert a conditional directive prior to task #3:

– Place your cursor anywhere on task #3.

– Press Home.

– Press Enter and then move your cursor up to the blank line.

– Click the If button on the Author toolbar.

Author inserts text for a conditional directive and positions your cursor at the
point where the condition is stated.

A conditional directive describes an “if-then” situation.

2 How to specify the condition for task #3:

– Without moving the cursor, type: 
the windows are open

– Replace the first “?” with 3. (Be sure not to replace or delete the # sign.)

– Replace the second “?” with 4.

Notice how the conditional directive indicates two paths: (1) what to do if the 
windows are open, and (2) what to do if the windows are not open.

3 Update the procedure flowchart.

Click the Flow button on the Author toolbar.
.....................................................................................................................................................
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The conditional directive appears on the flowchart in a diamond-shaped decision 
block, with a Yes path and a No path.

Note: At the end of the procedure, you will find a directive called End of Activity. 
This directive is automatically part of the procedure skeleton, but it can also be added 
by clicking the End button on the Author toolbar.

Changing Actors

Suppose task #4 is performed by another person.

To show this, you need to specify another actor:

1 How to insert an Actor paragraph prior to task #4:

– Place your cursor anywhere on task #4.

– Press Home.

– Press Enter and then move the cursor up to the blank line. 

– Click the Actor button on the Author toolbar.

Author inserts a shaded paragraph, formatted in the Actor style, and then positions 
your cursor inside the paragraph.

2 How to identify the actor for task #4:

– Type:
Chief Washer

– Do not press Enter.

3 Update the procedure flowchart.

Click the Flow button on the Author toolbar.

The flowchart shows the new actor—and the task associated with that actor—in a 
separate task block.
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Author Tutorial
Completing the Introductory Sections

Assume that you have completed writing all of the tasks for this activity. Your next 
step is to complete the preface and introductory sections for the procedure.

Writing the Activity Preface
1 Move your cursor up to the Activity Preface section.

Delete the first italicized paragraph (which contains writing instructions).

2 Describe the trigger, or circumstance, that initiates the activity.

– Complete the skeleton sentence so that it reads: 
This activity is performed whenever the color of the 
car is unrecognizable.

– Verify that you have used the Body Text style for this sentence.

– Delete the next five lines (which contain text for identifying a generic actor).

To learn more about generic actors, refer to Writing a Procedure [INS1050A].

3 Enter the procedure that occurs prior to this procedure (if applicable).

Writing the Procedure Introduction
1 Define the scope of the document.

– Move your cursor to the top of the document.

– Delete the italicized paragraph under Scope.

– Complete the first sentence by typing: 
washing the car by hand.

– Complete the second sentence by typing: 
washing the car using a drive-through car wash.

2 Identify each policy (or rule) that affects the performance of this activity.

– Move your cursor to the Policy section.

– Delete the italicized text, making sure to leave a blank paragraph formatted 
in Body Text style.

– Type the following paragraphs:

The family car is washed with approved, nonabrasive 
cleaner only.
Wasting water is strictly prohibited.

– Press Enter between paragraphs.
.....................................................................................................................................................
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– Make sure these paragraphs are formatted in the Body Text style.

3 Write one responsibility statement for each actor in the procedure.

You will be summarizing the primary duty (or duties) for each person who 
performs tasks in the activity.

– Move your cursor to the Responsibility section.

– Delete the italicized instructions.

– Edit the skeleton sentence to read:

The Chief Washer is responsible for washing and 
rinsing the car.

– Press Enter.

– Type the following statement: 

The Car Wash Supervisor is responsible for 
supervising the washing operation.

4 Complete the Distribution section.

This section should list (at a minimum) the actors who appear in the procedure.

Author automatically generates this list for you.
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Author Tutorial
– Select Author from the Main menu.

– Select Update Distribution Section.

Author inserts the actors in alphabetical order. The asterisks indicate that these 
job titles were automatically added by Author. 

You can add other job titles to this list, but do not add the asterisk.

5 Specify ownership.

The Owner is the person who has ultimate responsibility for defining or changing 
the activity this procedure describes.

– Move your cursor to the Ownership section.

– Replace Job Title with Head of Family.

6 Update the procedure effective date.

– Select Author from the Main menu.

– Select Document Properties.
.....................................................................................................................................................
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– Replace the effective date (mm/dd/yy) with Draft 1.

It is recommended that you specify draft levels instead of an effective date
during the writing phase. Once a procedure is ready for distribution, the draft
level should be replaced with the effective date.

– Click Update.

7 Print and review your procedure.

Notice the footer information that is automatically included in your procedure.

8 Save and close the document.

You have completed the first part of this tutorial.

To learn more about Author, continue with “Expanding the Procedure.”
.....................................................................................................................................................
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Author Tutorial
Expanding the Procedure

You will now open a completed version of the procedure Washing the Car.

Notice the expanded policy and responsibility statements, the additional information 
in the preface, and the expanded tasks.

Review the procedure formatting, especially the paragraph styles that are used to 
format bulleted text.

Adding Task Detail

The tasks that you wrote for Washing the Car were all primary tasks—that is, they 
focused on the main actions of the activity—and they were formatted in the Task 1 
style.

Suppose that you now want to explain how some of these tasks are performed. 

You can do this by adding secondary tasks.

1 How to add a secondary task to task #2:

– Position your cursor on task #2. 

– Press End, then press Enter to insert a blank line.

– Click the right arrow button on the Author toolbar.

– Notice that the paragraph style has changed to Task 2.

– Type: 
Follow the directions on the container.

2 How to add another secondary task to task #2.

– Press Enter.

– Notice that the paragraph style is still Task 2:

– Type: 
Use warm water.

– Do not press Enter at the end of this line.

If You Are Still in Author If You Have Exited Author
Select File/Open. Open Author.
Open the Tutor/Author 
directory.

Select Open Existing Document, then 
click OK.

Select PRO0002A. Open the Tutor/Author directory.
Click Open. Select PROC0002A. 

Click Open.
.....................................................................................................................................................
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You have successfully added information that tells the Car Wash Supervisor how 
to complete task #2. 

Writing Notes

Sometimes a task requires further explanation, rather than how-to information. This 
kind of information is included as a note.

1 How to insert a note under task #3:

– Move cursor to task #3. 

– Press End, then Enter.

– Click the Note button on the Author toolbar.

– Notice how the paragraph style is now Note 1.

– Type: 

Be sure you check the sunroof as well.

– Do not press Enter.

2 How to insert a note under a secondary task:

(Notes can be added to any level task.)

– Go back to task #2.

– Move your cursor to the last secondary task. 

– Press End, then Enter.

– Click the Note button on the Author toolbar.

– Notice that this time the paragraph style is Note 2.

The Note 2 style is used for all secondary tasks.

The Note button automatically applies the correct style, based on the preceding 
task.

– Type: 
The water in the hose may be warm enough.

3 How to review the Note List style:

– Scroll down to task #8.

– Notice that the list under the note is formatted in the Note List 1 style.

– Select the two lines formatted as Note List 1.

– Click the Note button on the Author toolbar.
.....................................................................................................................................................
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Author Tutorial
The paragraph style is changed to Note 1.

– Click the Note List button on the Author toolbar.

The style is changed back to Note List 1.

Whatever level note you are writing (Note 1, Note 2, or Note 3), clicking the Note List 
button produces the proper list format for that note.
.....................................................................................................................................................
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Using the Author Arrow Buttons

The arrow buttons on the Author toolbar help you to quickly change paragraph styles.

The left and right arrow buttons change styles based on paragraph type. For example, a 
Task 1 can be quickly changed to a Task 2, and vice versa, or a Note 1 can be changed 
to a Note 2.

The up and down arrow buttons change style based on the hierarchy of paragraph 
types. A Note 1 paragraph, for example, always follows a Task 1 paragraph, so this 
predictable relationship is captured by the up and down arrow buttons. A Task 1 can be 
quickly changed to a Note 1, and vice versa.

Using the left and right arrow buttons:

1 Scroll to task #5.

2 Position your cursor on the first secondary task.

3 Click the right arrow button on the Author toolbar.

– The paragraph style is changed to Task 3.

– A Task 3 paragraph is used to provide how-to detail for a secondary task. 

4 Now click the left arrow button on the Author toolbar.

The paragraph style is changed back to Task 2.

5 Click the left arrow once more.

Now the paragraph style is Task 1.

The left and right arrow buttons change paragraphs to the next higher (or lower) level 
within a paragraph type. This is called promoting and demoting paragraphs.

You may also use the left and right arrow buttons to promote or demote Note 
paragraphs and Note List paragraphs. For example, if you click the right arrow button 
on a Note 1 paragraph, Author changes it to a Note 2 paragraph.
.....................................................................................................................................................
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Author Tutorial
Tips on Promoting and Demoting Paragraphs

The promote and demote feature is most useful when you edit a procedure, because it 
enables you to change the amount of information that appears on your flowchart. 
(Remember, the flowchart shows only primary tasks.)

1 Read task #7 and its secondary tasks.

Suppose you decide that the secondary tasks should be included on the flowchart.

2 Select all four secondary tasks (Task 2 paragraphs).

3 Click the left arrow button on the Author toolbar.

Notice that all four paragraphs are promoted to Task 1.

4 Click the number (#) button on the Author toolbar.

5 Review tasks #9 through #12.

These are the promoted secondary tasks.

6 Review the directive after task #16.

Notice that the task numbers in the directive are correct—in other words, they have 
been renumbered as well.

Using the Up and Down Arrow Buttons

Position your cursor on the note under task #20.

1 Press End, then Enter.

The blank paragraph is formatted as Note 1.

2 Click the down arrow button on the Author toolbar.

The blank paragraph is now formatted as Note List 1.

3 Click the up arrow button.

The paragraph returns to Note 1 format.

4 Click the up arrow button once more.

The paragraph is now formatted as a Task 1.

The up and down arrow buttons link supporting paragraphs with root paragraphs. This 
is called the parent-child relationship.

Because Note 1 paragraphs always follow (or support) Task 1 paragraphs, and Note 
List 1 paragraphs always support Note 1 paragraphs, Author is able to anticipate 
relationships between paragraphs, enabling you to toggle between paragraph styles 
that are naturally linked.
.....................................................................................................................................................
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You will explore how this works in subsequent sections.

Tips on Using the Up and Down Arrow Buttons

The up and down arrow buttons are most useful when you are writing new text—either 
writing a new procedure or adding new tasks to an existing procedure.

Suppose you want to add a task, a note, and then another task to your procedure.

1 Position your cursor on the blank Task 1 paragraph at the end of the procedure.

Your cursor will already be in this position if you are continuing from the previous 
tasks in this tutorial.

2 Type:
Empty the ashtrays.

3 Do not press Enter.

4 Click the number (#) button on the Author toolbar.

You have just added another task to your procedure.

5 Press Enter.

6 Click the down arrow button on the Author toolbar.

You have just toggled to the Note 1 style.

7 Type:

The ashtray may be difficult to clean if it contains 
gum.

8 Press Enter.

9 Click the up arrow button.

You have toggled back to a Task 1 paragraph and are ready to write another task.

10 Type:

Polish the chrome.

11 Do not press Enter.

12 Click the number (#) button on the Author toolbar.

The up and down arrow buttons enable you to toggle quickly between styles that 
naturally follow each other.
.....................................................................................................................................................
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Author Tutorial
Adding the Final Touches

Once you are satisfied that your procedure is complete (and accurate), you need to 
prepare the document for distribution. This includes updating the document 
information and creating a final flowchart.

1 Update document properties, as needed.

– Select Author.

– Select Document Properties. Verify the document title.

This is the only place in which you should change a document title. The title 
that appears in the document and in the footer is in fields that are controlled by
the Document Properties window.

– Enter an effective date for your procedure.

This is the only place where you should change an effective date. The effective 
date that appears in the document and in the footer is in fields that are controlled 
by the Document Properties window.

When you have completed the draft phase, you should replace the draft level
with an effective date.

– Click Update.

2 Update the distribution section:

– From the Author menu, select Update Distribution Section.

3 Check the spelling in your procedure:

Because the flowchart text is derived from the procedure text, it is wise to check 
the spelling before you create your final flowchart.

Note: The word “goto” will probably be incorrect according to the Word spelling 
checker; however, it is required by Author and should not be replaced.

4 Renumber your procedures:

– Click the number (#) button on the Author toolbar.

You should always renumber your procedure before generating a flowchart.

5 Generate a final flowchart for your procedure:

– Click the Flow button on the Author toolbar.

6 Save and close your procedure.

7 Create an HTML document if needed:

– Click the HTML button on the Author toolbar.
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Publishing on the Web
Author enables you to create HTML versions of your documents, complete with 
hypertext links and links to e-mail and Web sites, along with options for creating 
custom documents and footers.

This section includes information on the following Author features:

Topic Description
Converting to HTML Format Instructions for converting a document to HTML 

format with a hypertext link
Managing HTML Files An explanation of the HTML Options section of the 

Author menu
Linking to an E-Mail Address Instructions for creating an HTML document with an 

e-mail link
Linking to a Web Site Instructions for creating an HTML document with a 

link to a Web site
.....................................................................................................................................................
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Publishing on the Web
Converting to HTML Format

The following instructions cover converting a sample procedure (PRO0002A) to 
HTML format.

1 Open PRO0002A through Author.

If you are continuing from the previous tutorial, you will already have this 
document open.

– Open Author.

– Select Open Existing Document, then click OK.

– Open the Tutor/Author directory.

– Select PRO0002A.DOC.

– Click Open.

2 Scroll to the end of the Activity Preface section.

Notice the reference to Returning from a Camping Trip [PRO0003A].

3 Underline the entire external reference.

Returning from a Camping Trip [PRO0003A]

The underlining designates this as a reference that needs to be hyperlinked in the 
HTML version of the document. The underline must include both square brackets.

Note: This step is not required in order to generate an HTML version of the 
document. It is required, however, if you want hyperlinks in the document after it 
is converted to HTML.

4 Save the document.

5 Click the HTML button on the Author toolbar.

Author creates an HTML version of the document and then returns you to 
PRO0002A.DOC.

6 Exit Author.

7 Open Windows Explorer.

8 Open the Tutor/HTML directory.

9 Open the PRO0002A folder.

This folder contains four documents. These are supporting files for your HTML 
procedure and should not be deleted.

10 Double-click PRO0002A.HTM.

This opens your browser and the HTML files containing PRO0002A.
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11 Note the menu panel on the left side of the screen. This panel enables the user to 
navigate quickly to the various sections within the document. For example, 
clicking the Tasks menu link takes you to the Actor prior to task #1. The menu 
links are derived directly from the document sections—that is, every heading 
formatted in the Section Title or Page Title style is picked up as a menu link. This 
applies to all Tutor documents: procedures, navigations, reference documents, and 
so on.
.....................................................................................................................................................
26 Tutor Author User’s Guide



.....................................................................................................................................................
Publishing on the Web
12 Click the Flowchart menu link.

– Move your cursor to task #1.

The hand that appears on the screen indicates a hyperlink.

– Click task #1.

The hyperlink takes you to task #1 in the procedure.

13 Scroll down to the directive under task #2.

– Click the underlined link #4.

– The hyperlink takes you to task #4 in the procedure.

14 Scroll up to the hypertext link at the end of the Activity Preface.

15 Click the highlighted text.

Your browser opens Returning from a Camping Trip [PRO0003A].

16 Click Back to return to PRO0002A.

17 Close your browser.

Managing HTML Files

All of the HTML documents created by Author are stored in your HTML directory, 
each within its own folder. All of these HTML folders (as well as any online desk 
manuals created with Tutor Publisher) must reside in the same HTML directory in 
order for the links to work properly.

The path for the HTML directory is specified under Author/HTML Options. The 
directory Tutor\HTML is automatically set up by Tutor, but if you change the path, 
all existing HTML folders must be moved to the new location. (Publishing to your 
company’s intranet is as easy as copying all of the content of the HTML directory to a 
Web server).

The HTML Options window also gives you options for displaying the HTML 
documents.
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Hide Bracketed File Names This option creates HTML documents in which the 
actual bracketed file name of linked documents does not appear. For example, notice 
that in the previous Publishing on the Web example, the link for Returning from a 
Camping Trip does not show the bracketed file name of [PRO0003A].

Include HTML Header This option places a custom header at the top of each 
HTML document. This header can be your company logo and can contain hyperlinks 
to other sites. This HTML code for this header is located in the Tutor\Author\ 
HeaderFooter directory in the Header.txt file. It is appropriate for a 
webmaster to create or edit the contents of this file. Notice the custom header that 
appears at the top of the HTML document in the previous Publishing on the Web 
example.

Include HTML Footer This option places a custom footer at the bottom of each 
HTML document. This footer is usually used to display your company’s copyright 
information. For example, in the previous Publishing on the Web example, notice that 
at the very bottom of the HTML document are the words “Copyright 1999 Your 
Company. All rights reserved.” This footer can be created in the 
Tutor\Author\HeaderFooter directory in the Footer.txt file. You would 
replace “Your Company” with your company name.

Display Effective Date This option places the effective date of the document at the 
bottom of the HTML document. This effective date can be entered in the Document 
Properties window. (Tutor will automatically display the effective date in your 
browser’s title bar following the document title.)
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Display Revision Number This option places the revision number of the document 
at the bottom of the HTML document. The revision number can be entered in the 
Document Properties window. (Tutor will automatically display the effective date in 
your browser’s title bar following the document title.) 

HTML Header Comment This field enables you to enter a comment (typically 
something such as “Uncontrolled Copy if Printed”) that appears at the top of each 
document printed from your browser. This field is limited to 60 characters.

Linking to an E-Mail Address

Author also enables you to create a hyperlink to an e-mail address. This can be useful 
when notifying the Document Owner and Document Controller when a document 
needs updating. Because personnel within a company can change, while job roles 
remain the same, it is recommended that you use an e-mail list with job roles instead of 
a specific person’s e-mail address. There are two ways to display an e-mail link in an 
HTML document.

To display the actual job role as the link in an HTML document:
1 Insert the job role followed by the e-mail address anywhere in the Author 

document. 

If you wish to populate the subject line of the e-mail with the file name of the 
document the user is viewing, you include a question mark and the word 
“subject=” followed by the file name. The following example will create an e-mail 
link in a document that populates the subject of the e-mail with the document file 
name (NAV1234):

[someone@yourcompany.com?subject=NAV1234]

2 Underline the entire reference, including the end bracket. For example:

3 Click HTML. This creates an HTML document with an e-mail link that only 
includes the job role that appears prior to the actual e-mail address. For example:
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– In the Ownership section of the HTML document, notice the link to Purchasing 
Manager.

– When you place your cursor over this link, the actual e-mail address appears at 
the bottom of the window. Clicking this link takes you to a browser mail 
function.

To display an <e-mail> link in an HTML document:
1 Insert the job role followed by the e-mail address anywhere in the Author 

document. 

2 Underline only the e-mail address, including the beginning and end brackets. For 
example: 

3 Click HTML. This creates an HTML document with an e-mail link that looks like 
<e-mail>. For example:
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– In the Ownership section of the HTML document, notice the link to <e-mail>.

– When you place your cursor over this link, the actual e-mail address appears at 
the bottom of the window. Clicking this link takes you to a browser mail 
function.

Note: Clicking an e-mail link takes you to a browser mail function. Your Information 
Technology department must set up the connection to your company’s e-mail system 
in order for e-mail to be sent properly.
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Linking to a Web Site

Author also enables you to create a hypertext link to a Web site.

To establish a link to a Web site:

1 Insert the URL address for the Web site anywhere in the procedure.

– Include the complete URL address.

For example:

Refer to the Oracle Web site [http://www.oracle.com].

– Make sure the entire reference is underlined.

– Make sure the URL address is in brackets.

The reference should be formatted just like any other document reference.

2 Save the document.

3 Click the HTML button on the Author toolbar.

Author creates an HTML version of this document, complete with a hypertext link 
to the specified Web site.

The resulting link in the HTML document does not include the specific URL 
address. It simply reads (in highlighted text):

Refer to the Oracle Web site.

The URL address is visible in your browser status bar when the cursor is placed 
over the link.
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Miscellaneous Features
The following section covers the various features and functions associated with the 
Author toolbar and Author menu.

Topic Description
Author Toolbar Descriptions A description of each of the buttons on the Author 

toolbar
Author Menu Item Descriptions A description of each of the items on the Author menu
Quick Reference An explanation of the text and paragraph styles provided 

by the buttons on the Author toolbar
Author Paragraph Styles A description of the relationship between Author 

paragraph styles and the Author up and down arrow 
buttons

Formatting System References An explanation of how to create system references in the 
proper format

Updating the Distribution 
Section

A description of the update distribution utility
.....................................................................................................................................................
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Button Description
Actor Formats current paragraph in the Actor style
Task Formats current paragraph in the Task 1 style
Note Formats current paragraph in the Note style
Note list Formats current paragraph in the Note list style
Box Formats current paragraph as a boxed paragraph for system references

Refer to “Formatting System References.” 
Body Formats current paragraph in the Body Text style
•— Inserts the List Bullet style, which includes the bullet and the proper 

indentation; used in the procedure introduction and in the Activity 
Preface

Refer to Writing a Procedure [INS1050A] for more information.
Arrows Enables you to toggle quickly between related Author styles; for 

example, clicking an up arrow moves you to parent style (if you click the 
up arrow while your cursor is on a Note 2 style, you are moved to a Task 
2 style)

If Inserts the required text for a conditional directive
Goto Inserts the required text for an unconditional directive, which is used to 

skip tasks

Refer to Writing a Procedure [INS1050A] for more information.
End Inserts “End of Activity,” which is the required text for the end of a 

procedure
N—> Inserts the —> symbol, which is used each time a navigation path is 

defined
Refer to Inserts the phrase “Refer to” and changes the font of the next character 

to italics (because all external document references appear in italics) 
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# Automatically numbers (or renumbers) all paragraphs formatted in the 
Task 1 style

Flow Creates a flowchart of all paragraphs formatted in the Task 1 style 
Flowcharts also show actor and directive information. (The flowchart 
appears at the end of the document.)

HTML Creates an HTML version of the document, including hyperlinks
? Takes you to the online Help system
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Notice that the top portion of this menu is the same as the Author toolbar, which is 
explained in the preceding section.

Menu Item Description
Document Properties Used to designate document title, effective date, and language; 

also used to set paper size and margins
Header/Footer Used to customize the header and footer 

Refer to “Customizing Headers and Footers.” 
Update Distribution 
Section

Used to populate the Distribution section in the introduction; 
all job roles used in the procedure appear in the Distribution 
section with an asterisk

Store Header/Footer Used to store a standard header/footer so that it can be copied 
into other documents

Refer to “Customizing Headers and Footers.” 
Replace Header/Footer Used to overwrite an existing header/footer with the stored 

header/footer

Refer to “Customizing Headers and Footers.” 
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Attach Author Template Attaches the Author template to an entire directory of 
documents

Refer to “Converting Existing Documents.” 
Update Flowchart 
Abbreviations

Used to change the words and phrases that are automatically 
abbreviated in an Author-generated procedure flowchart

Refer to “Using the Abbreviation Table.” 
HTML Options... Used to change your HTML directory and to customize the 

display of your HTML documents

Refer to “Publishing on the Web.” 
Update Table of Contents Used by Course Developers to update the table of contents in a 

curriculum-generated student guide (specifically, a student 
guide created using Tutor Publisher)

Refer to Building a Student Guide by Job Title [PRO1217A].
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Every type of paragraph (or type of information) in an Author procedure is associated 
with a predefined style. The more commonly used styles are associated with buttons 
on the Author toolbar.

The following table outlines each paragraph type, its associated style, and the Author 
toolbar button that is used to apply that style. The table also indicates if multiple 
buttons are required to apply a style or if a button’s function varies based on the 
paragraph style.

I
N
T
R
O

D

U

C

T

I

O

N

Paragraph Type Style Author Toolbar Buttons
Procedure title Page Title None
Section titles Section Title None
Scope statement Body Text Body
Policy statement Body Text Body
Policy list List Bullet •–
Responsibility statement Body Text Body
List of responsibilities List Bullet •–
Distribution Body Text Body
Ownership Body Text Body

P

R

E

F

A

C

E

Activity preface title Section Title None
Preface text (narrative) Body Text Body
Preface lists List Bullet •–
Generic job title list List Bullet •–
List of preceding procedures Body Text Body
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*Note: The N—> button inserts the proper arrow symbol—that is, an arrow that 
can be properly translated into HTML format. This button should be used each 
time a navigation path is defined.

T

A

S

K

S

Actor Actor Actor
Primary task (tasks required to 
complete the activity)

Task 1 Task

Secondary task (tasks required 
to complete a primary task)

Task 2 Task →
↑ (if in Note 2 style)

Tertiary tasks (tasks required to 
complete a secondary task)

Task 3 Task →→
→ (if in Task 2 style)

↑ (if in Note 3 style)
Systems reference/software 
applications

Box Text Box

Navigation arrow (within a 
system reference box)*

Box Text N→

Conditional directive Directive If
Unconditional directive Directive Goto
Primary notes (notes under 
primary tasks)

Note 1 Note (if in Task 1 style)

↓ (if in Task 1 style)

↑ (if in Note List 1 style)
Primary note list Note List 1 Note list (if in Note 1 style)

↓ (if in Note 1 style)
Secondary notes (notes under 
secondary tasks)

Note 2 Note (if in Task 2 style) 

↓ (if in Task 2 style) 

↑ (if in Note List 2 style)
Secondary note list Note List 2 Note list (if in Note 2 style)

↓ (if in Note 2 style)
Tertiary notes (notes under 
tertiary tasks)

Note 3 Note (if in Task 3 style) 

↓ (if in Task 3 style) 

↑ (if in Note List 3 style)
Tertiary note list Note List 3 Note list (if in Note 3 style) 

↓ (if in Note 3 style)
End of activity statement Directive End
References to other 
documents**

Any Refer to
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**Note: The Refer To button simply inserts the phrase “Refer to” and changes the 
font of the next character to italics (because all external document references 
appear in italics). This button is for the convenience of the document owner in that 
it simplifies typing. However, Author does not require the document owner to use 
this button for inserting document references.
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Author Paragraph Styles

The following diagram shows the relationship between Author paragraph styles and 
the Author up and down arrow buttons:

It is recommended that you practice using each of the Author buttons as you write 
your first procedure. 

Using Keystrokes to Format Paragraphs

For users who prefer using the keyboard instead of the mouse, Author provides 
keystroke alternatives to the arrow buttons on the Author toolbar.

Author Toolbar Buttons Keystroke Alternative
Left arrow button [Alt]+[Shift]+[←] (left arrow on the keyboard)
Up arrow button [Alt]+[Shift]+[↑] (up arrow on the keyboard)
Down arrow button [Alt]+[Shift]+[↓ ] (down arrow on the keyboard)
Right arrow button [Alt]+[Shift]+[→] (right arrow on the keyboard)
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Formatting System References

Tutor procedures include references to other applications. For example:

23. Update inventory.

Refer to Perform Miscellaneous Transactions [NAV0701A].

These system references show a navigation path (in the box), followed by references 
to related navigation instructions, if applicable.

System references should be formatted according to the following rules:

1 A system reference must appear below a Task 1 paragraph. That is, system 
references are always subordinate to primary tasks.

The primary task describes the intent or purpose of the application use.

2 System references are formatted in the Box Text style.

In the example above, each of the three lines in the system reference is a Box Text 
paragraph. When you press Enter at the end of a Box Text line, the box expands to 
accommodate the reference.

3 The information in the system reference is sequenced as follows:

– The first line in the system reference identifies the application.

– The last line identifies the unique destination screen name.

– The lines in between identify the navigation path—that is, the path within the 
application that leads to the screen.

– Multiple lines may appear between the first and last lines.

4 The arrow symbol in the navigation path is inserted using the N→ button.

5 References to related navigation instructions follow the system reference box, 
formatted in the Note 2 style.

You may use the Refer to button on the Author toolbar to format these references.

6 Screen names (along with corresponding navigation instructions) are referenced in 
the System References section of the procedure introduction.

Oracle Application Screens
Inventory Sub Transfer [NAV0703A]

Miscellaneous Transaction [NAV0701A], [NAV0702A]

Oracle Inventory

N→Transactions→Miscellaneous

Miscellaneous Transaction
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On Hand Quantities

Notice that not all screens have corresponding navigation instructions.

Updating the Distribution Section

Author includes a utility for repopulating distribution lists in procedures.

This utility copies, to the distribution section, job titles from Actor bars and job titles 
listed under the generic job title string in the preface. Note that the generic job title 
must appear in at least Actor bar for this utility to copy the associated job titles to the 
distribution section. Job roles picked up by this utility and placed in the distribution 
section are formatted with an asterisk at the end of the job title.

You can add job titles to the distribution list that do not appear in the procedure, and 
these will not be deleted by this utility.

Note: Legal separators for job titles are the words "and" and "or" and a comma (,). 
Characters that are assumed to be a part of a job title are ampersands (&), slashes (/ or 
\) and dashes (-).
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This section includes information on how to use the advanced features of Author. The 
following items can be found in the Author menu:

Topic Description
Customizing Headers and 
Footers

A description of how to create customized headers and 
footers for printed Tutor documents

Specifying Site (or location) Instructions for creating a specific site or location text 
string in the header of Tutor documents

Changing Margins Instructions for changing the margins in Tutor 
documents, including setting margins for use with A4 
paper

Using the Abbreviation Table Instructions for customizing the flowchart abbreviations 
using the Abbreviation Table

Converting Existing 
Documents

Instructions for converting existing documents to the 
Author format

The Tutor Language Tables Information on using the Tutor language tables
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Customizing Headers and Footers

Author allows you customize the headers and footers of created documents. You need 
to determine the content and format of the new header and footer information, along 
with the proper font, spacing and tabs, and number of lines. Both the header and footer 
are limited to three lines each.

1 Open any Author document.

2 Select Author from the Main menu.

3 Select Header/Footer.

Author opens the Customize Header and Footer window where you can specify a 
left, center, and right component for each of the three lines in the header and 
footer. You can also define (or redefine) header and footer styles in the 
AUTHOR.DOT template, as needed.

For example, if your document titles are too long to fit into the standard Tutor 
footer (in some languages, document titles are often longer than 40 characters), 
you may want to reorganize the footer so that the document title is on a separate 
line.

4 Create a standard header.

– Specify each component of the header.

– Specify a style for each row in which there is header text. 

Note: Assign attributes to the Header, Header 2, and Header 3 styles, as needed.
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None of the header styles are used in the standard AUTHOR.DOT template.

5 Modify the standard footer.

– Modify the components of the footer.

Note: You may add your company name to Row 1 of the footer; however, the 
Oracle Copyright information must remain as it appears.

– Specify a style for each row in which there is footer text.

Note: Change the attributes for the Footer, Footer 2, and Footer 3 styles, as 
needed. These three styles are already defined in the AUTHOR.DOT template.

6 Click Update.

This changes the header and footer in the document to match the entries in the 
customize Header and Footer window.

7 Store the newly created header and footer information.

You will need to save the header and footer information so that it can be applied to 
other documents.

– Select Author from the Main Menu.

– Select Store Header/Footer.

8 Save and close the document.

9 Open another Author document.

10 Update the header and footer in that document.

– Select Author/Replace Header Footer, then click Update.

The header and footer are automatically updated to reflect the new standard.

11 Save and close the document.
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Specifying Site (or Location) 

Large companies often have procedures that reflect variations based on the site or 
location that is using the document. For example, a company might have several 
versions of its receiving procedure, each based on a corporate standard but each 
reflecting information unique to that site. Rather than assign a unique document name 
to each version (for example, Receiving—Ireland), Author enables you to set a field in 
the header or footer that indicates a unique site.

1 Open the Author document that is site-specific.

Be sure you open the document through Author.

2 Select Author/Document Properties.

3 Enter the site designation. In this example, The Family Residence is used as the 
unique site.

4 Click Update.

Now you must designate where in the header you would like the site information to 
appear.

5 Select Author/Header Footer.

6 Type {site} in the appropriate position of the header or footer. The brackets 
indicate that this is a field that will be maintained by Author. When the document 
.....................................................................................................................................................
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is printed, the site designation of The Family Residence will appear in the 
appropriate place on the header or footer.

The position, as well as the style associated with that line in the header or footer, 
determines how the site designation appears on the page.

7 Click Update.

8 Select Author/Store Header Footer.

This saves the header and footer for inclusion in other documents.

9 Save and close the file.
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Changing Margins

To customize the margins in your procedures:

1 Open any Author document.

2 Select Author/Document Properties.

3 Select Custom.

4 Change the margin settings.

Note: You may also change your margins to work with standard A4 paper by 
selecting A4 under paper size. The margin settings will automatically change. 
Click Update.

5 Adjust the tabs in the document header and footer, as needed.

6 Click Update.

7 Save the document.
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Using the Abbreviation Table

The text that appears in an Author-generated flowchart is derived directly from the 
actors, tasks and directives in the procedure. That is, the flowchart precisely matches 
the procedure text, with one exception: certain words and phrases are abbreviated (or 
dropped entirely), based on the information contained in the Author abbreviation 
table.

The abbreviation table is a user-maintained document that enables you to streamline 
your procedures without affecting their content.

Author is installed with a fully functioning abbreviation table. The table appears in 
English, but can be modified to accommodate any language. If the standard 
abbreviations are acceptable, you need not access the table at all. If you want to 
change or add abbreviations, the table is easily modified.

Accessing the Abbreviation Table
1 Open Author.

2 Select Open Existing Document, then click OK.

3 Locate and open any Author document.

4 Select Author from the Main menu.

5 Select Update Flowchart Abbreviations.

Author opens a document containing the abbreviation table. The existing entries 
represent the abbreviations, truncations, and deletions that are currently reflected in 
your procedures.

The following table shows a sample of the entries found in the abbreviation table

Sample Abbreviation Table 

Original Term Abbreviation Truncated Case Sensitive
Accounts Payable AP N N
Accounts Receivable AR N N
Department Dept N Y
General Ledger GL N N
Journal Voucher JV N N
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Information in the Abbreviation Table

Each entry in the abbreviation table includes four pieces of information.

Information 
Type

Description

Original Term The word or phrase to be abbreviated

This entry must reflect precisely what appears in the procedure text. 
The original term may be a word or a phrase of any length.

Abbreviation The abbreviation to be used on the flowchart

The abbreviation may include punctuation, such as periods or 
apostrophes, but there can be only one abbreviation per term. 
Whatever is defined in this column is exactly what Author uses for the 
flowchart.

If this field is blank, the original term is dropped from the flowchart.
Truncated Indicates whether the original term signals a truncation of the task text

If this field is activated, the appearance of the original term in a task 
causes Author to ignore all remaining text in that task. For example, if 
the phrase “using the” is set up to truncate, the following task:

“#4. Update inventory using the MR as the source document.” 

appears truncated on the flowchart as: 

“Update inventory. (4)”

Because all tasks containing the phrase “using the” will truncate, the 
truncation feature should be used judiciously. Normally, this field is 
used only when tasks routinely contain information that is not required 
on the flowchart.

If tasks are brief and concise, this field is usually not required.
Case Sensitive Indicates whether Author should be case-sensitive when searching for 

the original term in procedure text

This field applies only to the term that is being searched for; it does not 
apply to the abbreviation itself. In other words, when case sensitivity is 
indicated, Author abbreviates only those terms that match the original 
term case. For example, if Purchase Order is designated case-sensitive, 
Author abbreviates Purchase Order but not purchase order. Similarly, if 
purchase order is designated case-sensitive, Author abbreviates 
purchase order but not Purchase Order. In both instances, Author uses 
whatever abbreviation is designated in the table; it does not alter the 
case of the abbreviation or change it to match the located term.
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Deleting Entries

By deleting an entry, you eliminate the abbreviation from the flowchart.

To delete an existing entry from the table:

1 Select the entire row in the table.

2 Delete the row.

Changing Abbreviations

To change an existing abbreviation:

1 Position your cursor in the second column of the row in which the original term
appears.

2 Change the abbreviation, using whatever punctuation is required.

3 Do not change the Truncated field.

Changing Case Sensitivity

To change case sensitivity on an existing term:

1 Evaluate the impact of changing the term’s case sensitivity.

For example, the term customer is designated as case-sensitive on the standard 
abbreviation table. If the designation is changed to N, then all occurrences of the 
word customer (including Customer) are replaced with cust. 

2 Change the case sensitivity setting, as needed. 

Y designates case sensitivity; N designates no case sensitivity.

Adding New Terms

To add a new term to the abbreviation table:

1 Insert a new row anywhere in the table.

The existing terms are in alphabetical order, but this is not a requirement of the 
software.
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2 Identify the word or phrase in the first column.

– Identify a single word or phrase; in other words, do not include multiple 
entries.

– Avoid extra spaces.

– Do not press Enter.

If the term is too long to fit on one line, allow it to wrap to a second line 
within the cell; do not use a carriage return.

– Type the word or phrase exactly as it appears in your procedures.

3 Designate the abbreviation in the second column.

– Type the precise abbreviation that you want to see on the flowchart.

– Include appropriate punctuation.

– Do not press Enter.

– Avoid extra spaces.

– Designate the correct case (upper or lower) for the abbreviation.

Important: Regardless of what you put in the Case Sensitive column (N or Y), 
the abbreviation on the flowchart will always match what you put in this 
column. In other words, if you indicate Dept. as the abbreviation, the 
flowchart will always show an initial cap on this abbreviation. If you want 
Author to match the case of the term when it abbreviates, refer to the 
instruction below.

Setting Up an Abbreviation to Match Case

If you have a word or phrase that is sometimes in lowercase and sometimes in initial 
caps (such as Department and department), and you want Author to preserve the case 
when it abbreviates, you need to maintain two entries in the abbreviation table.

1 Insert two new rows in the abbreviation table. If the term already exists in the 
table, add just one new row.

2 Add two entries for the term, one specifying the uppercase version of the term and 
one specifying the lowercase version of the term.

Be sure to designate case sensitivity for both terms.

Original Term Abbreviation Truncated Case Sensitive
Department Dept. N Y
department dept. N Y
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Eliminating Terms

To eliminate a word or phrase from all flowcharts:

1 Insert a new row in the abbreviation table.

2 Designate the word or phrase to be eliminated in the first column.

3 Leave the second column blank.

This column must be completely void of all characters, including spaces.

4 Type N in the Truncated column.

5 Specify the case sensitivity for the term.

Case sensitivity is important when specifying terms to be eliminated. For example, 
if you want to delete the word is from all flowcharts, you should consider whether 
IS is a term that has another meaning, such as Information Services.

Saving Changes

To save changes to the abbreviation table:

1 Save the abbreviation table document.

2 Close the document.

The changes you make to the abbreviation table will be reflected in all future 
flowcharts.

Original Term Abbreviation Truncated Case-Sensitive
is N Y
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Advanced Features
Converting Existing Documents

Your existing process documents should be converted to the Author format so that 
consistency and integrity can be maintained across all of your documentation.

For best results, move all of the documents to be converted into a working directory.

1 Open any existing Author document.

This document does not need to reside in your working directory.

2 Select Author/Attach Author Template.

3 A window opens with the message “Do you want to attach the Author template to 
a selected set of files?” Click Yes.

4 Type the full path for the directory and file specifications (such as *.doc) that 
contain the files to be converted.

Select the Include Subfolders check box if you would like to include directory 
subfolders.

5 Click OK.

Author attaches AUTHOR.DOT to each file in the directory and updates any styles 
that it recognizes (that is, any styles that have matching names).

6 Open each file in Author.

7 Update the format to match the Author standard.
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Avoiding Errors
The Author functionality, particularly the task numbering and flowcharting features, 
requires correct formatting in your procedures. These tips will help you avoid 
commonly made mistakes.

1 Be sure you always open each procedure through Author. (Do not open the 
document by double-clicking the file in Windows Explorer.)

2 Be sure your procedure ends with an End of Activity statement, formatted in the 
directive style. The only text that can follow the last task is a goto directive(s) that 
points to another procedure.

3 Always use the tabs that are built into the various Tutor Author styles; for 
example, the Task 1 style includes a tab after the task number. Do not use the space 
bar to position text.

The numbering utility enables you to simply type primary tasks at the left margin, 
without typing any task numbers at all.

4 Do not use the Task 1 style for anything other than task paragraphs.

5 Do not use the Task 1 style for blank paragraphs.

6 Always use the number symbol (#) when designating task numbers in directives.

7 Make sure your procedure includes an Actor prior to task #1.

8 Do not begin your procedure with directives.

9 Always renumber and reflowchart procedures when editing. This will prevent 
context sensitive map errors when creating HTML versions of procedures.

10 Place blank lines before and after tables. You may want to format these blank 
paragraphs as "table" style.

11 Make sure all Tutor documents are opened, edited, and saved with the same 
version of Microsoft Word.

12 Always use the numerals 1 and 0 to indicate numbers; do not use the letter l or the 
letter O in place of these numerals.

13 Do not use symbol fonts. When using Word’s Insert/Symbol function, be sure to 
switch fonts to normal text.

14 Limit hard-coded formatting to italics (for document references), underlining (for 
hypertext links), and bold (for policy statements). 

15 When inserting a page break, make sure the cursor is at the beginning of the line.

16 Make sure every paragraph ends with a carriage return.
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Technical Issues
Technical Issues
The following sections list the guidelines that should be followed when installing 
Tutor.

Topic Description
System Requirements A description of the hardware and software 

requirements needed in order to install Tutor
Setting Word Options A description of the Word options that must be set in 

order for Author to work properly
Installing Author Instructions for installing Author
The Tutor Language Tables Tutor relies on the use of key words and phrases in 

order to create flowcharts. These key words and 
phrases are maintained in the Tutor language tables. 
The Tutor language tables are maintained centrally by 
the Document Controller.
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System Requirements

Hardware Requirements
The hardware requirements for the Document Controller’s PC are:

Software Requirements
The software requirements for the Document Controller’s PC are:

• Windows 95 or Windows NT 4.0 (service pack 3 or later)

• Microsoft Word version 7.0, Microsoft Word 97, or Microsoft Word 2000

• Microsoft Excel version 5.0 for Windows 95, Microsoft Excel 97, or Microsoft 
Excel 2000

• Internet Assistant for Word (shipped with Author) (for Windows 95 or Microsoft 
Word version 7.0 only)

• Any antivirus program capable of detecting Word macro viruses; for example, 
Norton AntiVirus

• Web browser with frame functionality supporting HTML 3; for example, Netscape 
Navigator or Microsoft Internet Explorer 2.0 or later

Equipment Recommended
Computer PC Pentium, 266 Mhz
RAM 128 MB
Hard drive 4 GB free space
CD-ROM 24×
Monitor Capable of 16-bit color
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Technical Issues
Setting Word Options

There are several Word options required by Tutor that should be verified before 
updating or creating documents. The following two lists designate the settings for 
Word 95 (also known as Word 7), Word 97, and Word 2000 users.

Settings for Word 2000 Users

From the View menu:

• Select Print Layout (when reading documents for content)

• Select Normal (when formatting and updating documents)

• Select Toolbars

– Select Standard

– Select Formatting

– Select Author

• Select Style Bar (this will toggle the Style Bar on and off; note that you must be in 
Normal View to see the Style Bar in a Word document)

From the Format menu

• Select Style

– In the List field

– Select Styles in Use (this lists, at a minimum, the styles available in 
Author)

– Click on Cancel to close the dialog box (your selection will be saved)

From the Tools menu

• Select Customize

– Select Options tab

– Clear Menus Show Recently Used Commands First

– Click on Close to save changes

• Select Options

– Select the View tab

– Set Field Shading to Always

– In Formatting Marks field, select All

– Select the General tab
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– Clear Navigation Keys for WordPerfect Users

– Select the Edit tab

– Select Typing Replaces Selection

– Select the Print tab

– Select Update Fields

– Clear Background Printing (critical when printing Desk Manuals)

– Select the Save tab

– Clear Always Create Backup Copy

– Clear Allow Fast Saves

– Clear Prompt for Document Properties

– Clear Prompt to Save Normal Template

– Select the File Locations tab

– Change the Documents location to \Tutor

• Select Autocorrect

– Select the AutoCorrect tab

– Clear Replace Text as You Type

– Select the AutoFormat as You Type tab

– Clear Automatic Bulleted Lists

– Clear Automatic Numbered Lists

– Clear "Straight Quotes" with “Smart Quotes”

– Clear Symbol Characters (--) with symbols (−)
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Technical Issues
Settings for Word 97 Users

From the View menu:

• Select Page Layout (when editing documents)

• Select Normal (when formatting documents)

• Select Toolbars

– Select Standard

– Select Formatting

– Select Author

• Select Style Bar (this will toggle the Style Bar on and off; note that you must be in 
Normal View to see the Style Bar in a Word document)

From the Format menu:

• Select Style.

– Select Styles in Use (this lists, at a minimum, the styles available in 
Author)

– Click on Cancel to close the dialog box (your selection will be saved)

From the Tools menu:

• Select Options

– Select the View tab

– Set Field Shading to Always

– In Nonprinting Characters field, select All

– Select the General tab

– Clear Navigation Keys for WordPerfect Users

– Select the Edit tab

– Select Typing Replaces Selection

– Select the Print tab

– Select Update Fields

– Clear Background Printing (critical when printing Desk Manuals)

– Select the Save tab

– Select Always Create Backup Copy

– Clear Allow Fast Saves
.....................................................................................................................................................
Tutor Author User’s Guide 61



.....................................................................................................................................................
– clear Prompt for Document Properties

– Clear Prompt to Save Normal Template

– Select the File Locations tab

– Change the Documents location to \Tutor

• Select AutoCorrect

– Select AutoCorrect tab

Clear Replace Text as You Type

– Select the AutoFormat As You Type tab

– Clear Automatic bulleted lists

– Clear Automatic numbered lists

– Clear "Straight quotes" with “Smart Quotes”

– Clear Symbol Characters (--) with Symbols (–)
.....................................................................................................................................................
62 Tutor Author User’s Guide



.....................................................................................................................................................
Technical Issues
Settings for Word 95 Users

From the View menu:

• Select Page Layout (when reading documents for content)

• Select Normal (when formatting and updating documents)

• Select Toolbars

– Select Standard

– Select Formatting

– Select Author

• Select Style Bar (must be Normal View to see the Style Bar in the Word document. 
This feature toggles the Style Bar on and off)

From the Format menu:

• Select Style

– Click on List

– Select Styles in Use (this lists, at a minimum, the styles available in Author)

– Click on Cancel to close the dialog box (your selection will be saved)

From the Tools menu:

• Select AutoCorrect.

– Clear Replace Text as You Type

• Select Options

– Select the Edit tab

Select Typing Replaces Selection.

• Select the Save tab.

Select Always Create Backup Copy.

Clear Allow Fast Saves.

Clear Prompt for Document Properties.

• Select the Print tab.

Select Update Fields.

Clear Background Printing.

• Select the File Locations tab.

Change the Documents setting to \Tutor.

• Select the View tab.
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Set Field Shading to Always.

• Select the General tab.

Clear Navigation Keys for WordPerfect Users.

• Select the Autoformat tab. 

• Click AutoFormat under Show Options For.

Clear all fields under Apply As You Type.

Clear all fields under Replace as You Type.

• Click on AutoFormat as You Type under Show Options For.

Clear all fields under Apply As You Type.

Clear all fields under Replace as You Type.
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Technical Issues
Installation Information

Author must be installed locally, that is, it cannot be run on a network. 

If you are using Word 7.0 with a NT4 workstation, you must ensure that your boot par-
tition (C drive) is 2 gigabytes or less. The Microsoft Internet Assistant, which converts 
graphics to GIF files during the HTML procedure, will not operate properly when the 
boot drive is bigger than 2 gigabytes. If Tutor is installed to a drive that exceeds 2 
gigabytes, all Tutor functions are normal, except the HTML conversion process will 
not convert files containing graphics. The Tutor install routine will display a warning 
message if you try to install to a drive bigger than 2 gigabytes.

The Tutor installation routine will not overwrite files that may contain user-defined 
information. These files are: Author.rul, Language.rul, Abbrtabl.doc, and Author.dot. 
When these files are encountered by the install process they are saved and renamed 
with a new extension. For example, Author.rul will become AuthorRUL.old. You will 
need to reconcile any changes that were made to the .old files with the new files cre-
ated by the install and recreate the changes in the new files.    

Recommendation

It is recommended that Tutor be installed by a user with system administrator privi-
leges. This will ensure that there are no restrictions to the Windows registry and that 
all uninstall functions will operate properly.

Prior to Installation

1. Verify that your system meets the hardware and software requirements.

See Hardware/Software Requirements [IMP0013A].

2. Exit all open Windows applications.
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Installing Author

1. Insert the Tutor CD. The Tutor Installations screen appears.

2. Click Tutor Author

3. Click Next to advance to the next screen.

4. The installation program prompts you for the destination folder.

The default is C:\Tutor\Author.

It is recommended that you accept this default. You cannot install Author to 
a network drive.

• Click Next to accept the default folder, or click the Browse button to choose a 
new folder.

5. The installation program loads Author and tells you when the installation is com-
plete.

If you are installing Author to a Windows NT computer running Word 
2000, you may be asked for which profiles you wish to install Author (this 
option is usually presented only when a network version of Word is used). 
You should choose any user that will access that system and needs to use 
Author.

6. You may restart your computer or wait until the entire Tutor installation is com-
pleted.

The Author icon is located in Start/Programs/Tutor.
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